Experiment HC-2

Recovery from Exercise

Note: The lab presented here is intended for evaluation purposes only. iWorx users should refer to the User Area on www.iworx.com for the most current versions of labs and LabScribe2 Software.
Experiment HC-2: Blood Pressure, Peripheral Circulation, and Imposed Conditions

Background

When the heart pumps blood into the arteries, there is a sudden increase in pressure in the arteries. The highest level of pressure, that occurs immediately after the ventricles contract, is known as the systolic blood pressure. The pressure in the arteries slowly declines as the heart relaxes. The lowest level of pressure, that occurs just prior to the next contraction of the ventricles, is known as the diastolic blood pressure.

This experiment is composed of a long-term exercise and a series of short-term exercises. The long-term exercise examines the effects of food additives on heart rate, blood pressure and peripheral circulation. The short-term exercises examine the effects of apnea, exercise, and temperature on blood pressure and peripheral circulation.

Warning: As explained above, this procedure involves stopping blood flow to the arm, which is potentially dangerous. Please take the following precautions.

Precautions

1. Know what you are doing ahead of time.
2. Do not leave the cuff inflated for any prolonged period of time (>20 seconds).
3. The subject should flex and extend their fingers between experiments to maintain blood flow.
4. This experiment should be performed by healthy individuals who do not have a personal or family history of cardiovascular or respiratory problems. It is preferable to use more than one subject during the course of the lab session.
Experiment HC-2: Blood Pressure, Peripheral Circulation, and Imposed Conditions

Equipment Required
PC or Mac Computer
IXTA data acquisition unit
USB cable
IXTA power supply
PT-104 Pulse plethysmograph
Plastic bags with ice, cold and hot water
BP-220 Non-invasive blood pressure transducer
BT-220 Black tygone tubing with Luer connectors

IXTA Setup
1. Place the IXTA on the bench, close to the computer.
2. Check Figure T-1-1 in the Tutorial chapter for the location of the USB port and the power socket on the IXTA.
3. Check Figure T-1-2 in the Tutorial chapter for a picture of the IXTA power supply.
4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA.
5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to turn on the unit. Confirm that the red power light is on.

Start the Software
1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is not available, click on the Windows Start menu, move the cursor to All Programs and then to the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window will appear as the program opens.
2. On the Main window, pull down the Settings menu and select Load Group.
3. Locate the folder that contains the settings group, IPLMv4.iwxgrp. Select this group and click Open.
5. After a short time, LabScribe will appear on the computer screen as configured by the BloodPressure-ImposedConditions-LS2 settings.
6. For your information, the settings used to configure the LabScribe software and the IXTA unit
for this experiment are programmed on the Preferences Dialog window which can be viewed by selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the **Experiment** button on the toolbar to open any of the following documents:

- Appendix
- Background
- Labs
- Setup (opens automatically)

**Blood Pressure and Pulse Transducers Setup**

1. Locate the BP-220 non-invasive blood pressure (NIBP) transducer ([Figure HC-2-S1](#)), and PT-104 pulse plethysmograph ([Figure HC-2-S2](#)), in the iWorx kit.

![BP-220 non-invasive blood pressure transducer](image1)

*Figure HC-2-S1: The BP-220 non-invasive blood pressure transducer*

![PT-104 pulse plethysmograph](image2)

*Figure HC-2-S2: The PT-104 pulse plethysmograph.*
2. Plug the DIN8 connector of the PT-104 into the Channel A5 input (Figure HC-2-S3).
3. Plug the tubing connector of the BP-220 into the channel labeled A2 on the front of the IXTA.
4. Calibrate the BP-220 and then put it aside until it is needed in Exercise 1.

![Figure HC-2-S3: The PT-104 pulse transducer and the BP-220 non-invasive blood pressure transducer connected to an IXTA.](image)

**Calibration of the Non-Invasive Blood Pressure Transducer**

**Procedure**

1. Lay the cuff of the BP-220 on the lab table.

2. Click on the Record button, located on the upper right side of the LabScribe Main window (Figure HC-2-S4). The signal should begin scrolling across the screen.

   **Note:** If the user clicks the Record button and there is no communication between the iWorx unit and computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is turned on and connected to the USB port of the computer. Click OK and select the Find Hardware function from the LabScribe Tools menu.

3. Click on the AutoScale button at the upper margin of the Pulse and Blood Pressure channels. Your recording should look like Figure HC-2-S4.

   - If the signal on the Pulse channel is upside down when compared to trace, click on the downward arrow to the left of the channel title and select the Invert function. The trace should now look similar to the one in the figure.
   - If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse plethysmograph to the finger.
4. Record data while the cuff is laying on the table for about 10 seconds.

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click on the Save button to save the data file.

Figure HC-2-S4: The output of the BP-220 non-invasive blood pressure transducer displayed on the middle channel of the Main window. Pulse is shown on the top channel and heart rate on the bottom.

**Units Conversion**

1. Scroll to the beginning of the calibration data for the BP-220 non-invasive blood pressure transducer.

2. Use the Display Time icons to adjust the Display Time of the Main window to show the 10 second set of data on the Main window at the same time. The required data can also be selected by:
   - Placing the cursors on either side of data required
   - Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment with the four selected pulse cycles to the width of the Main window.

3. Click the 2-Cursor icon (Figure HC-2-S5) so that two blue cursors appear on the Main window. Place one cursor on the beginning of the flat section of data and the second cursor on the flat section of data collected approximately 10 seconds later.
4. To convert the voltages at the positions of the cursors to the correct pressure values, use the Units Offset dialogue window (Figure HC-2-S6). To access this dialogue window, click on the arrow to the left of the channel title, Blood Pressure, to open the channel menu. Select Units from the channel menu, and select Set Offset from the Units submenu.

5. On the units conversion window, put a check mark in the box next to Apply units to all blocks. Enter “0” in the box: Set Mean Value between Cursors to:. Click on the OK button in the lower right corner of the window to activate the units conversion.

Figure HC-2-S6: The Units Offset dialogue window with the mean values set to “0”.

Experiment HC-2: Blood Pressure, Peripheral Circulation, and Imposed Conditions

Exercise 1: Measuring Blood Pressures
Aim: To determine the systolic and diastolic blood pressures in a reclining subject.

Procedure
1. Instruct the subject to rest in the supine position for at least five minutes before his or her blood pressure is taken.
2. While the subject is resting, place the blood pressure cuff around the upper portion of the left arm, just above the elbow. Place the PT-104 pulse plethysmograph on the volar surface (where the fingerprints are located) of the distal segment of the left middle finger. Wrap the Velcro strap around the end of the finger to attach the unit firmly in place.
3. At the end of the rest period, click on the Record button to begin recording the subject’s pulse, blood pressure, and heart rate.
4. Inflate the blood pressure cuff until the finger pulse wave on the Pulse channel disappears (Figure HC-2-L1).
5. Once the pulse wave disappears, release the cuff pressure at the rate of ~10 mmHg/second. Continue to release the pressure in the cuff until the aneuroid gauge reads 20 mmHg.
6. Click the Stop button.
7. The subject should continue to rest in the supine position between Exercises 1 and 2. To improve circulation in his or her arm, the subject should flex and extend their fingers to encourage blood circulation.
8. Select Save in the File menu.

Data Analysis
1. Scroll through the recording and find the section of data recorded before, during, and after the blood pressure cuff was inflated.
2. Use the Display Time icons to adjust the Display Time of the Main window to show the pulse, cuff pressure, and heart rate from the time prior to the occlusion of the artery to the pressure cuff being deflated. This section of data can also be selected by:
   - Placing the cursors on either side of the section of data needed.
   - Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment of data to the width of the Main window.
3. Click on the Analysis window icon in the toolbar (Figure HC-2-5 on page HC-2-3) or select Analysis from the Windows menu to transfer the data displayed in the Main window to the Analysis window.
4. Look at the Function Table that is above the uppermost channel displayed in the Analysis window. The mathematical functions that are listed should include V2-V1, Value1, Value2, T2-T1, and Mean. The values for these parameters from each channel are seen in the table across the top margin of each channel.

5. Once the cursors are placed in the correct positions for determining the blood pressures, the values for the blood pressures can be recorded in the on-line notebook of LabScribe by typing the names and values directly into the Journal.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter the names and values of the parameters from the recording to the Journal. To use these functions:
   - Place the cursors at the locations used to measure the cuff pressure on the Blood Pressure channel.
   - Transfer the name of the mathematical function used to determine the blood pressure to the Journal using the Add Title to Journal function in the ECG Channel pull-down menu.
   - Transfer the value for the blood pressure to the Journal using the Add Ch. Data to Journal function in the ECG Channel pull-down menu.

7. Once the cursors are placed in the correct positions for determining the systolic, diastolic, and pulse pressures, record the values for these pressures in the Journal using the one of the techniques described in Steps 5 or 6.
8. Use the mouse to click on and drag the cursors to specific points on the pulse and blood pressure recording to measure the following:

- **Systolic blood pressure.** To determine the subject’s systolic blood pressure, place a cursor on the first of the smallest pulse waves that reappear after the pressure from the cuff of the BP-600 is released. Value1 on the Blood Pressure channel is the subject’s systolic blood pressure. Enter this pressure in Table HC-2-L2.

- **Diastolic blood pressure.** To determine the subject’s diastolic blood pressure, place the other cursor on the first of the largest pulse waves that reappear as the pressure from the cuff of the BP-600 is released. Value2 on the Blood Pressure channel is the subject’s diastolic blood pressure. Enter this pressure in the table.

- **Pulse pressure,** which is the difference between the systolic and diastolic pressures. To measure the pulse pressure, leave the cursors on the pulses that were placed at the systolic and diastolic pressures. The value for V2-V1 on the Blood Pressure channel is the subject’s pulse pressure. Enter this pressure in the table.

- **Heart rate.** To measure the heart rate, place the cursors on either side of six adjacent pulses that occurred before the blood pressure cuff was inflated (Figure HC-2-L2). The value for Mean on the Heart rate channel is the subject’s average heart rate. Enter the heart rate in the table.

9. Determine the subject’s blood pressure class from Table HC-2-L1. List it in Table HC-2-L2.

---

**Figure HC-2-L2:** The pulse wave, the cuff pressure, and heart rate recorded before the occlusion of the brachial artery as displayed on the Analysis window. The cursors are in positions to measure the subject’s average heart rate.

<table>
<thead>
<tr>
<th>Class</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hypotensive</td>
<td>090</td>
<td>060</td>
</tr>
<tr>
<td>Normal</td>
<td>0120</td>
<td>and 080</td>
</tr>
<tr>
<td>Prehypertensive</td>
<td>120-139</td>
<td>or 80-89</td>
</tr>
<tr>
<td>Hypertensive Stage 1</td>
<td>140-159</td>
<td>or 90-99</td>
</tr>
<tr>
<td>Hypertensive Stage 2</td>
<td>0160</td>
<td>or 0100</td>
</tr>
</tbody>
</table>

Table HC-2-L2: Blood Pressures and Heart Rates from Subjects in the Class.

<table>
<thead>
<tr>
<th>Subject</th>
<th>HR (BPM)</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
<th>Pulse Pressure (mmHg)</th>
<th>BP Class</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Long and Short Term Experiments

Two types of experiments will be performed in this lab and student subjects should participate in only one type of experiment:

- Long-term experiment—in which measurements are taken every 20 minutes throughout the lab.
- Short-term experiments—in which measurements are taken during a manipulation conducted in the periods between the long-term experiment.
Exercise 2: Effects of Food Additives

The effect of food additives will be examined as a class project. If there are 10 lab groups, one individual from each group should participate in the long-term project. One suggestion includes having each willing individual drink 12 ounces of one of the following:

- Caffeinated, regular soda
- Caffeinated, sugar-free soda
- Decaffeinated, regular soda
- Decaffeinated, sugar-free soda
- Water (control)

Other possible studies could include the effects of eating foods with monosodium glutamate or drinking sports drinks with different levels of sugars and salts.

Procedure

1. Instruct the subject to sit and relax for at least five minutes before his or her blood pressure is taken.

2. Place the blood pressure cuff of the BP-600 around the upper portion of the left arm, just above the elbow. Place the PT-104 pulse plethysmograph on the volar surface of the distal segment of the left middle finger. Wrap the Velcro strap around the end of the finger to attach the unit firmly in place.

3. Use the same procedures outlined in Exercise 1 to record the subject’s blood pressures and heart rate from his or her upper left arm.

4. After recording the subject’s blood pressure while sitting and relaxing, have the subject consume his or her designated drink or food in a short period of time.

5. Every 20 minutes after the food or drink was consumed, have the subject sit down and relax. Record the subject’s blood pressures and heart rate for 15-20 seconds. Mark the recording by entering comments in the Mark box to the right of the Mark button and clicking the Enter key on the keyboard.

6. Select Save in the File menu.

Data Analysis

1. Use the same techniques used in Exercise 1 to determine and record the systolic, diastolic, and pulse pressures and heart rates of the subject at all the time intervals throughout the long-term experiment.

2. Enter the subject’s blood pressures and heart rates at each time interval in Table HC-2-L3.

Questions

1. Are there any differences among your subject’s blood pressures and heart rates at different time intervals?
2. Check the data from other subjects. Which treatment caused the greatest percentage change in the subject’s blood pressure?

3. Which treatment caused the greatest percentage change in the subject’s heart rate?

Table HC-2-L3: The Effect of Food Additives on Blood Pressure and Heart Rate

<table>
<thead>
<tr>
<th>Treatment</th>
<th>Heart Rate (BPM)</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
<th>Pulse Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (mins)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>120</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Warning: The subjects participating in the long-term project, Exercise 2: Effects of Food Additives, should not be subjects in the remaining exercises of this experiment. The subjects in the long-term project should function as data collectors for the remaining short-term exercises.

Exercise 3: Effects of Exercise

Aim: To examine the effects of exercise on blood pressure.

Procedure

1. Select a new subject and instruct the subject to sit and relax for at least five minutes before his or her blood pressure is taken.

2. Place the blood pressure cuff of the BP-600 around the upper portion of the left arm, just above the elbow. Place the PT-104 pulse plethysmograph on the volar surface of the distal segment of the left middle finger. Wrap the Velcro strap around the end of the finger to attach the unit firmly in place.

3. Use the same procedures outlined in Exercise 1 to record the subject’s blood pressures from his or her upper left arm.
4. After recording the subject’s resting blood pressure, remove the blood pressure cuff and pulse plethysmograph from the subject. Leave these devices connected to the iWorx 214.

5. Instruct the subject to exercise vigorously enough to elevate his or her heart rate. Walking up and down stairs or doing jumping jacks are suitable exercises.

6. While the subject is exercising, type Recovery from Exercise in the Mark box to the right of the Mark button.

7. Immediately after exercising, the subject should sit in a chair. Other members of the group should attach the pulse plethysmograph and blood pressure cuff to the subject as done in Step 2.

8. Click on the Record button, inflate the cuff and record the data needed to determine the subject’s blood pressure immediately after exercise. Press the Enter key on the keyboard as the subject’s blood pressure is recorded. After the data needed to determine the subject’s blood pressure is recorded:
   - Deflate the blood pressure completely.
   - Monitor the subject’s heart rate by continuing to record.

9. Every thirty seconds after the beginning of the recovery period, pump up the blood pressure cuff and record the subject’s blood pressure. Continue to record the subject’s blood pressure until the pressures are similar to the resting pressures.

10. Click Stop to halt recording.

11. Select Save from the File menu.

**Data Analysis**

1. Use the same techniques used in Exercise 1 to determine and record the systolic, diastolic, and pulse pressures and heart rates of the subject at all the time intervals throughout the exercise and recovery experiment.

2. Enter the subject’s blood pressures and heart rates at each time interval in Table HC-2-L4.

**Questions**

1. Compare the blood pressures before and after exercise. How long does it take your subject’s blood pressure to return to the resting level? How does the time it takes your subject’s blood pressure to return to normal compare to the times of other subjects?

2. Compare the heart rates before and after exercise. How long does it take your subject’s heart rate to return to the resting level? How does your subject’s recovery time compare to those of other subjects.
## Exercise 4: Effects of Apnea

**Aim:** To examine the effects of apnea (holding one’s breath) on blood pressure.

**Procedure**

1. Use the same methods used in Exercise 1 to record the subject’s resting blood pressures from the upper left arm.

2. Instruct the subject to take a deep breath, hold it for as long as possible, and then return to breathing normally. While the subject is holding his or breath, use the same methods used in other exercises to record the subject’s blood pressures.

3. As soon as the subject stops holding his or her breath, record the subject’s blood pressures and heart rate.

4. Record the subject’s blood pressure and heart rate every 30 seconds after the subject stops holding his or her breath.

5. Select Save in the File menu.

---

**Table HC-2-L4: The Effect of Aerobic Exercise on Blood Pressure and Heart Rate**

<table>
<thead>
<tr>
<th>Treatment ______</th>
<th>Heart Rate (BPM)</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
<th>Pulse Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (secs)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>120</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>150</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>180</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>210</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>240</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>270</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Data Analysis

1. Use the same techniques used in Exercise 1 to determine the systolic, diastolic, and pulse pressures of the subject at all the time intervals throughout the long-term experiment.

2. Enter the subject’s blood pressures and heart rates at each time interval in Table HC-2-L5.

Questions

1. What effect does apnea have on the subject’s blood pressure?
2. How does the subject’s blood pressure change when the subject resumes breathing after apnea?
3. What are the physiological causes of the changes you see in the blood pressure and heart rate.

Table HC-2-L5: The Effect of Apnea on Blood Pressure and Heart Rate

<table>
<thead>
<tr>
<th>Treatment</th>
<th>Heart Rate (BPM)</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
<th>Pulse Pressure (mmHg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (secs)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>90</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>120</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>150</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Exercise 5: Effects of Cooling the Forearm

Aim: To measure the effects of cold temperatures on the pulse amplitude and blood pressure.

Procedure

1. Use the same methods used in other exercises to record blood pressures from the subject’s right forearm. Mark the recording with comments to indicate the subject’s name, the location of the blood pressure cuff, and the temperature of the room.

2. After the blood pressures from the subject’s right forearm are recorded, remove the blood pressure cuff from the arm. Leave the pulse plethysmograph attached to the subject’s finger to monitor any changes in the subject’s pulse amplitude.

3. Type Ice Pack On in the Mark box to the right of the Mark button. Place an ice pack on the
ventral side (inside) of the subject’s right forearm. Put a couple of paper towels between the ice pack and the subject’s arm. Remind the subject to remain motionless during the recordings.

4. As soon as the ice pack is in place, click on the Record button. Press the Enter key on the keyboard to mark the recording. Record the subject’s pulse for about 10 seconds. Click on the Stop button.

5. At every minute into the ten-minute cooling period, record the subject’s pulse for about 10 seconds as it was done in Step 5.

6. Before the end of the ten-minute cooling period, type Ice Pack Removed in the Mark box. Be ready to wrap the blood pressure cuff around the subject’s right forearm as soon as the ice pack is removed.

7. At the end of the ten-minute cooling period, remove the ice pack from the subject’s arm, and wrap the blood pressure cuff around the subject’s right forearm as quickly as possible.

8. Click on the Record button and press the Enter key on the keyboard. Use the same methods used earlier to record and identify the blood pressures from the subject’s right forearm.

9. At every minute after the end of the cooling period, record and identify the subject’s blood pressures. Record every minute for five minutes.

10. Select Save in the File menu.

**Data Analysis**

1. Use the same techniques used in Exercise 1 to determine and record the systolic, diastolic, and pulse pressures and heart rates of the subject before and after the cooling period.

![Figure HC-2-L3: Pulses recorded during an early section of the cooling period displayed in the Analysis window. The cursors are in position to record the pulse amplitude.](image_url)
2. Measure the amplitudes of the pulses prior to the cooling period, during cooling at one-minute intervals, and after cooling at one-minute intervals:

- Scroll through the recording and find the section of data recorded at the beginning of the cooling period.
- Use the Display Time or Zoom between Cursors functions to adjust the Display Time of the Main window to show the first ten seconds of the pulse and heart rate at the beginning of cooling period.
- Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to transfer the data displayed in the Main window to the Analysis window (Figure HC-2-L3).
- Measure the pulse amplitude by placing one cursor at the beginning of the pulse wave and the other cursor at the peak of the pulse wave. The value for V2-V1 on the Pulse channel is the pulse amplitude. Use one of the two techniques described earlier to record this pulse amplitude in the Journal.
- Measure the amplitudes of two additional pulse waves adjacent to the first pulse wave measured. Enter these values in the Journal.
- Calculate the average of these three pulse amplitudes at this time interval. Record this mean in the Journal.
- Use the same methods to calculate and record the mean pulse amplitudes at the other time intervals in the cooling period.

3. Enter the subject’s blood pressures, heart rates, and mean pulse amplitudes at each time interval in Table HC-2-L6.

Questions

1. By examining the pulse data during the cooling period, determine if cooling has any effect on pulse amplitude? Explain your conclusion.
2. Determine if cooling has any effect on heart? Explain your conclusion.
3. Determine if cooling has any effect on blood pressure? Explain your conclusion.

Exercise 6: Effects of Warming the Forearm

Aim: To examine the effects of warming the forearm on blood pressure, heart rate and peripheral circulation.

Procedure

Use the same methods used in Exercise 5 to test the effects of warming the forearm of a new subject.

Data Analysis

1. Use the same methods used in Exercise 5 to analyze the data recorded in Exercise 6. Record the results in Table HC-2-L7.
**Questions**

1. By examining the pulse data during the warming period, determine if warming has any effect on pulse amplitude? Explain your conclusion.
2. Determine if warming has any effect on heart? Explain your conclusion.
3. Determine if warming has any effect on blood pressure? Explain your conclusion.

**Table HC-2-6: The Effects of Cooling on Blood Pressure, Heart Rate, and Pulse Amplitude.**

<table>
<thead>
<tr>
<th>Cooling Time (Mins)</th>
<th>Heart Rate (BPM)</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
<th>Pulse Pressure (mmHg)</th>
<th>Pulse Amplitude (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>After</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table HC-2-L7: The Effects of Warming on Blood Pressure, Heart Rate, and Pulse Amplitude.

<table>
<thead>
<tr>
<th>Warm. Time (Mins)</th>
<th>Heart Rate (BPM)</th>
<th>Systolic Pressure (mmHg)</th>
<th>Diastolic Pressure (mmHg)</th>
<th>Pulse Pressure (mmHg)</th>
<th>Pulse Amplitude (V)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prior</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>After</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>